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Intended Use 
OVA1® is a qualitative serum test that combines the results 
of five immunoassays into a single numerical result. It is 
indicated for women who meet the following criteria: over 
age 18, ovarian adnexal mass present for which surgery is 
planned, and not yet referred to an oncologist. OVA1® is an 
aid to further assess the likelihood that malignancy is 
present when the physician’s independent clinical and 
radiological evaluation does not indicate malignancy. The 
test is not intended as a screening or stand-alone diagnostic 
assay. 

PRECAUTION: OVA1® should not be used without an 
independent clinical/radiological evaluation and is not 
intended to be a screening test or to determine whether a 
patient should proceed to surgery. Incorrect use of 
OVA1® carries the risk of unnecessary testing, surgery, 
and/or delayed diagnosis. 

Summary and Explanation of the Test 
Ovarian tumors are being detected with increasing frequency 
in women of all ages. There are numerous recent 
publications clarifying the importance of a gynecologic 
oncologist in the care of subjects with ovarian cancer. The 
National Comprehensive Cancer Network (NCCN) [1] and 
the Society of Gynecologic Oncologists (SGO) [2] plus other 
studies have demonstrated the value of referring subjects 
with ovarian cancer to gynecologic oncologists for their 
surgery [3,4]. 

OVA1® should be used in conjunction with imaging studies 
and other clinical assessment in a woman for whom surgical 
intervention is planned. OVA1® can assist the decision- 
making process of whether to refer the subject to a 
gynecologic oncologist, when the referring physician’s 
presurgical assessment does not indicate malignancy. 

OVA1® is a device that incorporates the biomarker values 
from five immunoassays. The biomarker values used to 
generate the OVA1® result are Prealbumin – also called 

transthyretin (TT), Apolipoprotein A-1 (Apo A-1), β2 
Microglobulin (β2M), Transferrin (Tfr), and Cancer Antigen 
125 (CA 125 II) [5-7]. Biomarker values are determined 
using assays on the Roche cobas, an automated analyzer 
with electrochemiluminescence detection. The biomarker 
assays are conducted according to the manufacturer’s 
directions as detailed in the Instructions for Use for each 
product and in this Instructions for Use. The assay values 
from the following systems are manually entered into a .csv 
file and evaluated by the OvaCalc software: 

Roche cobas: 

• CA 125 II (Roche) 

• TT — Prealbumin (transthyretin) (Roche) 

• Apo A-1 — Apolipoprotein A-1 (Roche) 

• β2M — Beta-2 Microglobulin (Roche) 

• Tfr — Transferrin (Roche) 

The OvaCalc software combines the results from these five 
biomarker assays and then uses a proprietary algorithm to 
generate an OVA1® result. 

Principles of the Procedure 
Principles of the individual assays for Prealbumin (TT), Apo 
A-1, β2M, Transferrin (Tfr), and CA 125 II are as given in the 
respective Instructions for Use. 
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Patients are assigned a unitless result between 0.0 and 10.0 
by the OvaCalc software; the result is called the OVA1® 
score. This result is given in the OVA1® report as written 
below: 

Pre-menopausal 
Low probability of malignancy OVA1® < 5.0 
High probability of malignancy OVA1® ≥ 5.0 
Post-menopausal 
Low probability of malignancy OVA1® < 4.4 
High probability of malignancy OVA1® ≥ 4.4 

All reagent information for each individual assay that is 
run can be found in the following Instructions for Use.  

• Tina-quant Apolipoprotein A-1 ver.2 (Roche) 
• Tina-quant β2-Microglobulin (Roche) 
• Prealbumin (Roche) 
• Tina-quant Transferrin ver.2 (Roche) 
• CA 125 II (Roche) 
• CA 125 II CalSet II (Roche) 
• Calibrator f.a.s. Lipids (Roche) 
• β2-Microglobulin Calibrator (Roche) 
• Calibrator f.a.s. PAC (Roche) 
• Calibrator f.a.s. Proteins (Roche) 

Warnings and Precautions 
For In Vitro Diagnostic Use 

• See PRECAUTION in box following the intended 
use statement. 

• Only lot numbers for Prealbumin (transthyretin)), 
Apolipoprotein A-1, β2 microglobulin, Transferrin, 
and CA 125 II provided by AWH, Inc. can be used 
for OVA1®. 

• You should notify AWH if you detect problems with 
any of the assays used in the OVA1® test. Users 
should heed the warnings and precautions listed in 
each of the Instructions for Use for the individual 
assays, in addition to those listed here. 

• Only the reagents and systems specified in the 
Materials Required, Not Provided section are for 
use with OVA1®. The performance of OVA1® has 
not been evaluated with any other manufacturer’s 
reagents or systems. 

• Use routine laboratory precautions. Do not eat, 
drink, or smoke in designated work areas. 

• Do not use heat-inactivated samples or samples 
stabilized with azide. 

IMPORTANT: It is critically important to have a second 
operator (reading from the Roche cobas source reports) 
verify all manually entered values and specimen IDs, 
after data entry into the .csv data file but prior to 
manually merging (importing) the data from the Excel 
data file into OvaCalc. (Please refer to Section 4 
Running OvaCalc Software for a complete explanation 
of data importing and further verification.) 

Specimens 
• OVA1® is for use with serum only. 

• Do not use plasma for OVA1®. 

• Do not use specimens that are heat-inactivated or 
stabilized with azide. 

• As specified in the Instructions for Use of the 
individual biomarker assays: 

o Serum specimens must be completely 
coagulated and, after centrifugation, must not 
contain any particles or traces of fibrin. 

o Lipemic samples or frozen samples that are 
turbid after thawing must be clarified by 
centrifugation (10 minutes at ~15,000 x g) prior 
to testing. Lipemic samples that cannot be 
clarified should not be used. For testing, the 
clarified portion of the sample must be used, 
and must be drawn through the supernatant 
lipid layer. 

o Ensure serum specimens to be tested are at 
ambient temperature (20-25°C) before 
measurement. 

o Diluted samples must be used within 4 hours of 
dilution. 

Storage 
The storage and stability of the OVA1® individual assays is 
summarized below. 
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Table 1. Stability of OVA1® reagents. 

 CA 125 
(Roche) 

ß2 micro-
globulin 
(Roche) 

Transferrin 
(Roche) 

Storage 
+2 to 
+8°C 

Do not 
freeze 

 
+2 to +8°C 

Do not freeze 
+2 to +8°C 

Do not 
freeze 

Stability 
once 

opened 

 
12 

weeks at 
+2 to 
+8 °C 

 
12 weeks at 

+2 to 
+8 ° C 

 

8 days 
at +2 to +8 

°C 

On-board 
Stability 

 
6 weeks 

 
12 weeks 

 
8 weeks 

 

 
 

Prealbumin 
(Roche) 

 
Apolipoprotein 

A-1 (Roche) 

Storage +2 to +8°C 
Do not freeze 

+2 to +8°C 
Do not freeze 

Stability 
once 

opened 
3 days at +2 

to +8°C 
8 days at +2 

to +8°C 

On-board 
Stability 

8 weeks 12 weeks 

Table 2. Serum specimen stability. 
 Fresh serum stored at +2 to +8°C can be used up 

to 8 days. 
 Serum frozen within 24 hr at –20°C is stable up to 9 

weeks. 
 Serum frozen within 24 hours and stored at –65 to 

–85° is stable up to 12 weeks. 

Materials Provided 
OvaCalc Software for download from the manufacturer. 
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Materials Required, Not Provided 

Table 3. Materials required  

Assay Manufacturer 

Tina-quant Apolipoprotein A-1 ver.2: 
03032566122 

•Calibrator f.a.s. Lipids:12172623160 

•PreciControl ClinChem Multi 1: 
05947626160 

• PreciControl ClinChem Multi 2: 
05947774160 

• Diluent NaCl 9 %:04489357190 

  

  

Roche 

Tina-quant β2-Microglobulin 140 tests: : 
08047430190 

• β2-Microglobulin calibrator: 
08047545190 

• β2-Microglobulin Control Set Serum: 
08362785190 

• Diluent NaCl 9 %: 04489357190 

  

  

Roche 

Prealbumin: 20764655322 

• Calibrator f.a.s. PAC: 03555941190  

•PreciControl ClinChem Multi 1: 
05947626160 

•PreciControl ClinChem Multi 2: 
05947774160 

•Diluent NaCl 9 %: 04489357190 

  

  

Roche 

Tina-quant Transferrin ver.2: 
03015050122 

• Calibrator f.a.s. Proteins: 11355279160 

• Precinorm Protein: 10557897160 

• Precipath Protein: 11333127160 

• Precinorm U: 10171735122 

• PreciControl ClinChem Multi 
1:05947626160 

• PreciControl ClinChem Multi 2: 
05947774160 

• Diluent NaCl 9 %: 04489357190 

  

  

Roche 

Cancer Antigen 125 (CA 125 II): 
11776223161 

•Calibrator:CA 125 II CalSet II: 
07030207190 

• PreciControl Tumor Marker: 
11776452160  

  

  

  

Roche 

Non-reagent materials 

Excel software, version 2003 or later Microsoft 



           

 Page 6 of 21 PRC000391 v 7.00 

Individual materials for each of the above listed assays are 
found in the respective Instructions for Use. Only AWH 
qualified lot numbers for Prealbumin, Apolipoprotein A-1, β2 
microglobulin, Transferrin, and CA 125 II provided by AWH, 
Inc. can be used for OVA1®.  

The Roche cobas system is the required platform. All 
information on Use, Installation, Principles of Operation, 
Performance Characteristics, Operating Instructions, 
Precautions, and Limitations, Hazards, and Maintenance for 
the instruments can be found in the respective Instrument 
and/or Software Manuals for the cobas System. 

 

Minimum computer requirements for OvaCalc Software: 

• Operating System - Microsoft Windows XP 

• Free disk space - 100 MB 

• Processor - 1 GHz 

• Memory - 512 MB RAM 

Assay Characteristics and Components 
Information on assay characteristics for each of the 
individual biomarker assays can be found in the respective 
Instructions for Use and Table 4 following. 

 

Table 4. Performance characteristics of the 
individual biomarker assays in OVA1®. 

Biomarker Measuring 
Interval 

ß2M 
(Beta-2 microglobulin) 

0.2-8.0 mg/L 

Tfr 
(Transferrin) 10-520 mg/dL 

TT 
(Prealbumin also known as 
transthyretin) 

 
3-80 mg/dL 

Apo A-1 
(Apolipoprotein A1) 

20-400 mg/dL 

CA 125 II 
(Cancer antigen 125) 

2.0-3000 IU/mL 

Controls Required for Each Biomarker 
Assay 
Each biomarker assay control must fall within the expected 
range for the controls used with the assays. Follow 
manufacturers’ instructions for tracking the controls and 
instrument calibration data over time. Instrument calibration 
must be performed per the manufacturer’s recommendations 
or when controls are out of specification. 

Procedure 
IMPORTANT: Only the specific assays listed in this 
Instructions for Use can be used to generate the OVA1® 
result. 

OvaCalc 3.0.3 runs on both Windows XP and Windows 7 
operating systems. 

1 Installing OvaCalc Software 
Note: This procedure is done only the first time you use 
the software, and anytime you need to reload the software 
onto your computer. 

A. Verify that the date and time are correct on your 
computer system. 

B. To install OvaCalc, contact the manufacturer and follow 
instructions. 

i. Click OvaCalc Software and log in by entering your 
Username and Password. (Note: Web site usernames 
and passwords are unique for OvaCalc Software 
operators and are obtained from AWH.). 

ii. Double-click Download OvaCalc Software, then click 
Run in the File Download window to start downloading 
the software. 

iii. Follow instructions on where to store OvaCalc on your 
computer (OvaCalc installs automatically onto your 
computer). 

iv. To run OvaCalc, double-click the OvaCalc icon in 
Windows. 

C. Log in using the default OvaCalc Administrator account 
(username and password are case sensitive): 

• Username — admin 

• Password — admin123 

D. In the main toolbar, click Manage Users (  ) and 
change the username and password of the OvaCalc 
Administrator account. 

1) Select admin and click Edit. 

2) Type new name and password, then click OK. 

E. Create one or more new user accounts at this time. 
Note that user accounts can be Administrative (full 
access) or Basic (restricted access). 

1) Click New in the Manage Users window. 
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2) Enter new user information, then click OK. 

 
3) Repeat for as many users as needed. New users 

are listed in the Manage Users window. When 
done, click OK. 

F. Exit the OvaCalc software. 

2. Activation 
You must obtain an Activation Code for each computer for a 

defined number of OVA1® tests from AWH before you can 

run OvaCalc. 

A. Open OvaCalc software and log in: 

• User– admin 
• Password – admin123 

 



           

 Page 8 of 21 PRC000391 v 7.00 

B. Select File > Counter Log. 

 

C. In the Counter Log window, record your System ID, 

found in the upper right. 

 

D. Send an email to OVA1data@aspirawh.com with the 

following: 

• Your System ID 
• Your request for an Activation Code for a specific 

number of OVA1® tests (500, 1000, 2000, 5000, or 

1 million tests). 

E. When you receive your Activation Code, select File > 

Counter Log. 

F. Click Activate. 

 

G. In the Add Activations window, enter your Activation 

Code and click OK. 

 

• The current activations and last purchased number 

and date are shown in the Counter Log window. 

 

• Note that an Activation Code can be used only 

once. Activations are deducted after each data 

import and a new activation code must be obtained 

from AWH when all activations are used up. 

3. Automated QC Control 

A. Select File > QC Control. 

  

B. In the QC Control window, go to Processing Frequency 

and select Daily or Weekly, then click OK to close the 
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window or click Process Files Now to perform a QC check 

immediately. 

 

Note: Embedded data from the five QC Controls spanning 

the OVA1® range are automatically imported to calculate 

OVA1® scores based on your selected frequency. 

C. When you open OvaCalc, a Success pop-up dialog box 

opens to indicate that QC Control has been performed 

according to the processing frequency and all QC control 

tests pass. Click OK to close. 

 

D. To view, print, and save the OVA1® scores of the five QC 

Controls and the accumulated record of performed QC, 

select File >QC Report (or click  in the tool bar).  

  

E. In the Audit Trail window, select the Start and End dates 

you want, then click Query to view the Audit Trail. The Audit 

Trail includes the date and time that QC was performed and 

the calculated OVA1® scores of the five embedded QC 

Controls. 

 
F. Copy the Audit Trail to an Excel spreadsheet. 

i) Right click over the entries to open the 

context menu. 

 

A QC Results 

Report (PDF) is 

generated.  

Click Print and/or 

Save in the report 

toolbar. 
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ii) Select Copy Table. 

iii) Paste the table into your Excel worksheet. 

4. Running the Biomarker Assays 
Run each of the following Biomarker Assays according to the 
manufacturer’s instructions in the respective Instructions for 
Use. For Warnings and Precautions, Materials Required but 
Not Provided, and other detailed information, consult the 
appropriate Instructions for Use. 

A. For all assays: 

1) Set up your cobas instrument for the run 
following the analyzer-specific assay 
instructions in the appropriate Operator’s 
Manual. 

2) Bring reagents to approximately 20°C and 
place on reagent disk of analyzer. 

IMPORTANT: Avoid the formation of foam. 

Note: The system automatically regulates reagent 
temperature and opening/closing of bottles. 

3) The analyzer automatically calculates the 
assay concentration of each specimen in the 
appropriate units. 

B. Calibration and QC 

• For assays run on the cobas, a QC screen includes 
displays of the distribution of the measured results 
around the target value of a QC test, as detailed in 
the Software Guide. The calibration information 
encoded in the reagent pack is used to update the 
master curve. This process is specific to the 
reagent lot and/or pack. 

5. Preparing Data for OvaCalc Software Analysis 
A. Prepare Data for Analysis 

i. Excel is used to manually enter specimen IDs and 
results from the Roche cobas assays, saving the data 
as a comma-separated values (.csv) data file. 

ii. Note: The biomarker values are manually entered into 
the.csv data file in the measurement units provided by 
the cobas.  

iii. IMPORTANT: It is critically important to have a second 
operator (reading from the Roche cobas source 
reports) verify all manually entered values and 
specimen IDs, after data entry into the .csv data file but 
prior to manually merging (importing) the data from the 
Excel data file into OvaCalc. (Please refer to Section 4 

Running OvaCalc Software for a complete explanation 
of data importing and further verification.) 

B. Enter your data into a new Excel workbook created for 
OVA1® (only one sheet may be used in the workbook). 
Create columns with headings as follows: 

A. Specimen ID 

B. APO 

C. B2M 

D. TRF (TFR also accepted) 

E. TT 

F. CA125 

i. For columns B through F, use the Excel drop-down list 
Format > Cells to select two-decimal numeric display. 

C. Enter the Specimen ID and biomarker values for each 
specimen in rows under the column headers created in 
step 3 B. 

Note: If any of the biomarker values are automatically 
flagged from the cobas they should not be entered into the 
Excel workbook sheet and used for OvaCalc. OVA1® results 
should be calculated only with valid results for all analytes 
from a single serum specimen. 

i. The operator must re-analyze any specimen that is 
flagged for any of the biomarker values from the cobas. 

ii. The specimen ID can be any unique character 
sequence less than 64 characters long. Biomarker 
readings are entered as numbers, without commas or 
other special characters. Each line in the .csv file must 
contain a specimen ID and five biomarker readings to 
obtain an OVA1® result. If a column is blank or a 
biomarker value is missing, OvaCalc will not produce 
an OVA1® result, and a processing error message will 
result. If the readings are not parsed as numbers they 
will not be read. 

iii. Operators can enter and save data from several 
specimen runs through Excel into a single .csv data file 
before the data are imported into the OvaCalc 
database. No specimen ID should appear more than 
once in a single .csv file. If a specimen is analyzed 
(i.e., on the cobas) more than once, and calculation of 
the OVA1® result is needed for each set of analyte 
values, then the separate sets of values should be 
entered into separate .csv files and imported into 
separate OvaCalc folders (see below). 

D. Select File > Save As. 
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E. In the Save As dialog box, select CSV (Comma 
delimited)(*.csv) from the Save As Type drop-down list, 
enter a file name, then click Save. 

F. In the Excel dialog boxes that open, click OK, then click 
Yes to confirm .csv format. 

G. Perform a manual QC on the .csv data file. 

1) Have a second operator manually compare the 
Specimen IDs and values obtained from the cobas 
source reports with the data in the .csv data file. 
The second operator should correct any 
discrepancies, and confirm these corrections with 
the original operator. 

IMPORTANT: If a sample ID appears more than once in 
a .csv file, an OvaCalc error message appears when the 
data file is being imported into the OvaCalc database, 
stating Duplicate Sample ID and displaying the ID 
number (e.g., Duplicate specimen id 4007-1 in line 6). 
You must cancel the import operation, then reopen the 
.csv file in Excel and edit it to correct the duplication. 
The resaved .csv file can then be re-imported into the 
OvaCalc database. 

2) Save your QC’d .csv data file. 

6. Running OvaCalc Software and Data Analysis 
Note: 

• A “file” refers to the .csv data file where the 
specimen (sample) ID and biomarker values are 
manually entered by the operator from the cobas  

• An OvaCalc “folder” is a Windows file folder created 
or selected by the operator in OvaCalc. The data 
are imported from the .csv data file into the 
OvaCalc folder. 

• Data can only be imported into the OvaCalc folder 
from the .csv data file. Data cannot be manually 
entered into the OvaCalc folder. 

A. Launch the OvaCalc software (  ) from the desktop 
shortcut icon or from the Windows Start menu and log 
in. (Installing OvaCalc, above.) 

B. In the OvaCalc main toolbar, click New Folder  

(  ). 

C. Name the new folder and click OK. 

i. The new folder is listed in the Explorer pane, toolbar 
icons become enabled, and an empty Specimen View 
pane opens.  

D. Click Import Data (  ), then click Import from file to 
open the navigation window, navigate to and select the 
.csv file(s) to import for the run, then click Open. 

i.For every specimen ID that is identified during import, 
OvaCalc checks if the specimen ID is already in the 
OvaCalc database for the current OvaCalc folder. If a 
matching specimen ID is not found in the OvaCalc folder, a 
new record (for the specimen) is created in the OvaCalc 
folder. If a matching record (specimen ID) is found, the 
newly imported biomarker values are merged into the 
existing specimen ID record. New biomarker values will 
amend existing readings in the OvaCalc database for the 
current folder; therefore the operator must create a new 
folder when the same specimen ID has new biomarker 
value(s) and both records are to be retained. 

ii. OvaCalc software over-writes biomarker values for 
specimen IDs that appear in more than one .csv file 
imported to a single OvaCalc folder. OvaCalc 
calculates the OVA1® result only after all five (5) 
biomarker values have been imported. 

E. In the Import dataset window, review the imported data 
and click Next to see the list of all specimens and 
values in the import. Continue clicking Next and follow 
prompts to confirm data. The import wizard prompts for 
data review before finalizing the import – this is a very 
important step to ensure that biomarker values are 
correct. If the operator detects any incorrect entries, the 
import operation must be cancelled, the value(s) 
amended and confirmed in the .csv data file (opened in 
Excel, edited and resaved), and the .csv file must be re-
imported. The final page of the import wizard shows run 
dates. 

F. When done, click Finish and all data for the current 
OvaCalc folder are displayed in the Specimen Result 
View pane. In the Specimen Result View, a table with 
data for each Specimen ID and the OVA1® result is 
given. You can click and drag the margins of the 
columns to change viewing size. The run is 
automatically saved in OvaCalc for all OVA1® results 
and five (5) biomarkers for each specimen ID. Operator 
should confirm/release the entire “run” before 
processing/printing any final reports. 

7. Printing Final Reports 
1. Highlight the specimens for the report by clicking and 

dragging the mouse over the appropriate rows. 
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2. In the main toolbar, click Physician Report  

(  ) to view, print and save the report. 

3. To export the Run Report as a delimited .csv file, go to 

the main toolbar and click Run Report (  ). In the 

Save window, create a file name and save the Run 

Report as a .csv file (make sure that .csv files is 

selected for Files of Type). In the OvaCalc confirmation 

dialog box click OK. The Run Report opens after 

clicking OK. 

 

Note: If you do not want to export the Run Report as a 

.csv file, click Cancel in the Save window to open the 

Run Report without saving. 

4. To save as a .pdf file, go to the report window, use the 
report toolbar to save. 

5. You may also print or examine the report using the 
report toolbar. When done, click OK at the bottom of the 
report window. 

8. Automatic sending of Counter Log to AWH 
A. OvaCalc automatically sends a counter log to 

ova1data@aspirawh.com once a week, starting from the 
date of installation. When OvaCalc is opened, a counter 
log is automatically exported and saved to the hard 
drive of computer with the default filename of 
UsageCount_mm_dd_yyyy, where mm_dd_yyyy 
represents the month, day and year of export. 

B. A dialog box confirms that counter log has been saved. 

 

C. A second dialog box confirms that counter log has been 
sent to AWH. 

 

D. In the event of email failure, the following dialog box 
opens. 

 

Result Reporting 
A run report is generated for operator verification and lists 
Specimen ID and OVA1® result. A flag is displayed in the 
Flag column if the value cannot be reported or there is no 
value. 

The report to the Physician is patient specific and should be 
released only after all the results in the run report are verified 
by the operator. This report contains the same information 
as in the run report (the requesting physician’s and 
laboratory director’s information with the specimen 
information, e.g., Patient DOB and age, and report date can 
be written in by operator after printing). 

The results for OVA1® are as follows: 

Pre-menopausal 
Low probability of malignancy OVA1® < 5.0 
High probability of malignancy OVA1® ≥ 5.0 
Post-menopausal 
Low probability of malignancy  OVA1® < 4.4 
High probability of malignancy  OVA1® ≥ 4.4 

Refer to clinical study section below for information about 
determining menopausal status. Results of this test should 
always be interpreted in conjunction with the patient’s 
medical history, clinical presentation and other findings. See 
PRECAUTION statement following the intended use at the 
beginning of the Instructions for Use. 

Expected Values 
The distribution of OVA1® results determined in specimens 
from healthy individuals and patients with nonmalignant or 
malignant diseases other than ovarian cancer is shown in 
the following tables. A total of 360 evaluable specimens 
were analyzed. The mean, standard deviation, median, and 
5th to 95th percentile as observed in the data are shown for 

mailto:ova1data@aspirawh.com
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each group. It is recommended that each laboratory 
establish its own reference range for the population of 
interest. 

Expected OVA1® results for subjects with cancer conditions 
other than ovarian cancer are presented in Table 5 following. 

Expected OVA1® results for subjects with non-cancer 
conditions are presented in Table 6 following. 

Table 5. Expected OVA1® results for subjects with 
cancer conditions. 

 Bladder 
Cancer 

Breast 
Cancer 

Cervical 
Cancer 

Colon 
Cancer 

 OVA1® result 
N 16 45 12 40 

Mean (SD) 4.57 
(1.109) 

4.34 
(1.151) 

6.40 
(1.979) 

4.86 
(1.259) 

Median 4.4 4.1 6.6 4.8 
5th to 95th 
percentile 

2.9 to 6.5 2.9 to 6.0 3.4 to 9.8 3.0 to 7.0 

 

 Endometrial 
Cancer Leukemia Lung 

Cancer Lymphoma 

 OVA1® result 
N 44 10 13 13 

Mean (SD) 5.00 
(1.467) 

6.04 
(0.651) 

4.17 
(0.884) 

5.26 
(1.669) 

Median 4.6 6.1 4.0 4.6 
5th to 95th 
percentile 

3.5 to 8.3 4.6 to 7.0 3.0 to 
5.5 

3.0 to 8.6 

 

Table 6. Expected OVA1® results for subjects with 
non-cancer conditions. 

 Autoimmune 
Disease 

Cardiac 
Disease 

Diabetes 

 OVA1® result 
N 10 12 40 

Mean (SD) 5.23 
(1.083) 

5.28 
(1.345) 

4.39 
(1.069) 

Median 5.3 5.6 4.0 
5th to 95th 
percentile 

3.4 to 6.6 3.3 to 8.0 3.2 to 6.4 

 

 Endo-
metriosis 

Hepatitis Kidney 
Disease  

Pregnant 
Women  

 OVA1® result 
N 40 13 10 12 

Mean (SD) 5.01 
(1.189) 

4.46 
(0.832) 

5.23 
(1.083) 

5.28 
(1.345) 

Median 4.7 4.2 5.3 5.6 
5th to 
95th 

percentile 

3.4 to 7.1 3.5 to 6.0 3.4 to 
6.6 

3.3 to 8.0 

 

 
Anemia Pelvic 

inflammatory 
disease 

Malnutrition 

 OVA1® result 
N 11 9 10 

Mean (SD) 3.73 
(0.673) 

4.52 
(1.072) 

4.30 (0.948) 

Median 4.0 4.4 4.4 
5th to 95th 
percentile 

2.7 to 
4.7 

3.2 to 6.3 2.8 to 5.7 

Reference Values 
OVA1® results in healthy women, 69 pre- and 78 post-
menopausal were evaluated (total = 147 evaluable subjects). 
Ages ranged from 18 to 85 and represented whites (81.3%) 
Hispanic/Latino (8.7%) and African American (7.3%) 
subjects. Expected OVA1® results for healthy subjects are 
presented in Table 7. 
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Table 7. Summary of OVA1® results by 
menopausal status for evaluable women. 

 All 
Healthy 
Subjects 

Premenopausal 
Women 

Postmenopausal 
Women 

 

N 147 69 78 

Mean (SD) 4.18 
(0.858) 

4.34 (0.871) 4.04 (0.827) 

Median 4.10 4.30 3.95 
Range 

(min, max) 2.7, 6.7 2.9, 6.7 2.7, 6.1 

Reference 
interval 

(5th 
percentile, 

95th 
percentile) 

3.0, 5.8 3.0, 5.8 2.9, 5.9 

OVA1® Result, n (%) 
Positive 46 ( 

31.3% ) 
20 ( 29.0% ) 26 ( 33.3% ) 

Negative 101 ( 
68.7% ) 

49 ( 71.0% ) 52 ( 66.7% ) 

Troubleshooting 
Problem Possible Cause and Solution 

Error message – 
Imported data file 
cannot be read. 

Possible corruption of .csv file. 
Review .csv data file. 
Re-enter Specimen IDs and/or 
results as needed. 
Import corrected file into 
OvaCalc software. 

Error message – 
Duplicate 
Specimen ID in 
the Excel .csv 
data file. 
Eg: Duplicate 
specimen id 
4007-1 in line 6 

Review .csv data file and correct 
any duplications. 
Import corrected file into 
OvaCalc software. 

Error message – 
Specimen 
missing one or 
more values. 

1. Possible error in imported 
data file. 
Review cobas data output to 
ensure specimen ID has a 
marker result. 
Reconcile with .csv data file. 
Re-import into OvaCalc 
software. 

Problem Possible Cause and Solution 
2. Possible syntax error in data 
file. 
Review .csv file and correct 
column headings to match 
following: 
Specimen ID 
APO 
B2M 
TFR 
TT 
CA-125 
Ensure Specimen ID and all 
values are entered correctly. 
Import corrected file into 
OvaCalc software. 

Cannot print 
reports. 

Printer-specific problem. 
Save report as a PDF and print 
the PDF. 

Report printed 
with header 
missing. 

Printer-specific problem. 
Save report as a PDF and print 
the PDF. 

Specimen IDs in 
OvaCalc result 
table not in 
sequential order 

Specimen IDs do not show in 
the same order as in the 
imported .csv file: 
Export and save Counter Log 
and send to AWH for record-
keeping.** 
Open Counter Log window and 
record or take and save screen 
shot of: Current Activations 
Number, Last Purchased Date, 
and Purchased Number. 
Ensure all .csv data files, Run 
Run Repots, and QC Reports 
are backed up. 
Uninstall OvaCalc. 
Download the same version of 
OvaCalc from as provided. 
Install the downloaded OvaCalc 
to the same directory as 
previous installation on your 
computer. 
Run OvaCalc. Confirm transfer 
of data folders, Counter Log, QC 
Report, and Activations. 
Note: Downloading to a different 
directory deletes the existing 
database, counter log, QC, and 
activation information. 
**Must be done before uninstall. 
Existing database and counter 
log are not affected only if same 
version of OvaCalc is reinstalled. 
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Limitations of the Procedure 
Information on the Limitations of the Procedure for each 
of the individual biomarker assays is detailed in the 
respective Instructions for Use. 

• OVA1® is not a screening test. (See Tables 6 and 
7) 

• OVA1® is not a stand-alone diagnostic test. OVA1® 
should be used in conjunction with a complete and 
independent clinical patient evaluation. 

• A negative OVA1® result, in the setting of a positive 
pre-surgical assessment, should not preclude 
oncology referral. 

• Use of this assay is limited to personnel who have 
been trained by AWH, Inc. in the procedure. Failure 
to follow the instructions given in this insert may 
result in erroneous results. 

• OVA1® is not indicated for patients with a diagnosis 
of malignancy within the last 5 years. 

• All collected data from each of the individual five 
biomarkers must be manually transferred from the 
cobas printouts using the same units specified by 
the printouts into the .csv data file using Excel. 
Manual data entry verification must be performed 
before completing the import into OvaCalc 
software. 

• Only reagents that have been qualified by AWH are 
acceptable for use with OVA1®. Users should verify 
manufacturer’s lot numbers are qualified for 
individual biomarker assays and calibration 
reagents.  

• Samples that have been heat-inactivated or 
stabilized with azide cannot be used. 

• Samples that contain rheumatoid factor ≥ 250 
IU/mL cannot be used in the OVA1® test. 

• Triglyceride levels above 4.5 g/L may interfere with 
the assay and should not be used in the OVA1® 
test. 

• Follow manufacturers Instructions for Use for CA 
125 II, Prealbumin (TT), and β2M for information 
about hook effects. There is no high dose Hook 
effect for Apo A-1 up to a concentration of 900 
mg/dL or for Prealbumin up to a concentration of 
300 mg/dL. 

• Patient samples may contain heterophilic 
antibodies and anti-mouse antibodies that could 
cause false results in some of the immunoassays. 

Refer to individual Instructions for Use (Apo A-1, 
β2M and CA 125 II) for further details. 

Clinical Study Results 
The information provided by OVA1® should be used by the 
physician as an adjunctive test to complement, not replace, 
other diagnostic and clinical procedures. To demonstrate 
that OVA1® provides additional information when used in 
combination with the physician’s pre-surgical assessment, 
the ability of OVA1® to contribute to the physician’s pre-
surgical assessment was analyzed. 

OVA1® was evaluated in a prospective, double-blind clinical 
study. OVA1® analysis was performed on 516 individual 
serum specimens collected prospectively from women who 
met the study inclusion criteria and proceeded to surgery for 
an ovarian mass. The clinical study population came from 
institutions with primary care physicians, gynecologists (non-
GO), and/or gynecologic oncologists (GO). The clinical study 
subject enrollment centers are representative of institutions 
where ovarian tumor subjects potentially undergo a 
gynecologic examination. The specimens were collected at 
27 demographically mixed sites that included large and small 
medical centers (universities/community hospitals), clinics 
that specialize in women’s health, small 
gynecology/obstetrics groups, gynecology/oncology 
practices, and HMO groups). 

Subject enrollment demographics and pathology diagnoses 
are given in Table 8. 

Table 8. Demographic characteristics and 
pathology results or physician assessment results 
for all evaluable subjects. 

 

All Evaluable 
Subjects with 
Pre-surgical 
Assessment 
(N= 516) 

Non-GO  
Physicians 
(N= 269) 

GO  
Physicians 
(N= 247) 

Age, years 
 N 516 269 247 
 Mean (SD) 52.0 (13.9) 49.7 (13.6) 54.6 (13.8) 
 Range (min, max) 18 to 92 19 to 90 18 to 92 
Menopausal Status, n (%) 
 Pre 235 (45.5%) 144 (53.5%) 91 (36.8%) 
 Post 281 (54.5%) 125 (46.5%) 156 

(63.2%) 
 
 
Pathology Diagnosis, n (%) 
Benign ovarian 
conditions 355 (68.8%) 197 (73.2%) 158 

(64.0%) 
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All Evaluable 
Subjects with 
Pre-surgical 
Assessment 
(N= 516) 

Non-GO  
Physicians 
(N= 269) 

GO  
Physicians 
(N= 247) 

Epithelial ovarian 
cancer (EOC) 96 (18.6%) 45 (16.7%) 51 (20.6%) 

Other primary 
ovarian 
malignancies (non 
EOC) 

9 (1.7%) 5 (1.9%) 4 (1.6%) 

Ovarian tumors with 
low malignant 
potential 
(Borderline) 

28 (5.4%) 12 (4.5%) 16 (6.5%) 

Non-ovarian 
malignancies with 
involvement of the 
ovaries 

18 (3.5%) 5 (1.9%) 13 (5.3%) 

Non-ovarian 
malignancies with 
no involvement of 
ovaries 

10 (1.9%) 5 (1.9%) 5 (2.0%) 

Note: Menopausal status stated by patient. For 44 evaluable 
subjects, menopausal status assigned based on age: pre-
menopausal assigned to women aged 50 or under, post-
menopausal assigned to women over age 50. 

Performance of OVA1® for Patients Evaluated by 
Physicians who are not Gynecologic Oncologists (non-
GO) 
A total of 269 patients (age range 19-90) were evaluated by 
non-GO (e.g., primary care physicians, gynecologists). Of 
the 269 patients, 144 subjects were identified as pre-
menopausal and 125 as post-menopausal. 

For each patient, the OVA1® result was compared to the 
pathology report from biopsied tissue. Malignancy included 
epithelial ovarian cancer (EOC), other primary ovarian 
malignancy, ovarian tumor with low malignant potential, 
malignancy extending to, or metastatic to ovaries, and 
malignancy that neither arose in nor involved the ovaries. 

High probability of malignancy for premenopausal subjects 
was defined as OVA1® result of 5.0 or more; and for 
postmenopausal subjects OVA1® result of 4.4 or more. 

Among 269 subjects, there were 72 subjects with 
malignancy by pathology and 197 subjects with no 
malignancy by pathology. 

Table 9. All non-GO evaluated subjects – 
malignancy/no malignancy by pathology. 

Malignancy by Pathology 

OVA1® 
result 

 Pre-surgical assessment 
Pos Neg Both 

Positive 49 14 63 
Negative 3 6 9 
Both 52 20 72 
No Malignancy by Pathology 

OVA1® 
result 

 Pre-surgical assessment 
Pos Neg Both 

Positive 16 81 97 
Negative 18 82 100 
Both 34 163 197 

The analysis examined whether patient referral to a 
gynecologic oncologist is supported when either the OVA1® 
result or the pre-surgical clinical assessment or both were 
determined to be positive. 

Table 10 shows results for all subjects evaluated by non-GO, 
with “positive” results for likely malignancy either based on a 
positive pre-surgical assessment alone (single assessment), 
or based on a positive result from the pre-surgical 
assessment or from the OVA1® result or from both (dual 
assessment). 

Table 10. All subjects evaluated by non-GO 
physicians. 

Performance Single 
assessment 
(pre-surgical 
assessment) 

Dual 
assessment  
(pre-surgical 

assessment and 
OVA1® Test 
result used) 

Sensitivity 
 95% CI 

72.2% (52/72) 
61.0% to 81.2% 

91.7% (66/72) 
83.0% to 96.1% 

Specificity 
 95% CI 

82.7% (163/197) 
76.9% to 87.4% 

41.6% (82/197) 
35.0% to 48.6% 

Positive 
Predictive 

value (PPV) 
 95% CI 

60.4% (52/86) 
49.9% to 70.1% 

36.5% (66/181) 
29.8% to 43.7% 

Negative 
Predictive 

Value (NPV) 
 95% CI 

89.1% (163/183) 
83.7% to 92.8% 

93.2% (82/88) 
85.9% to 96.8% 

Prevalence 26.8% (72/269) 
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With dual assessment, sensitivity for malignancy increased 
from 72% to 92%. That is, approximately two-thirds of the 
malignancies missed by pre-surgical assessment alone were 
called positive if a dual assessment was used. Specificity for 
malignant diagnoses decreased from 83% to 42% with dual 
assessment. The ratio of false positive results to true 
positive results for the study population increased from 34:52 
(0.65:1) with single assessment to 115:66 (1.74:1) with dual 
assessment (PPV of the dual assessment decreased from 
60% to 37%). However, NPV of the dual assessment 
increased from 89% to 93%, supporting improved 
performance by dual assessment. The confidence interval 
for the observed 4.1% increase was -0.5% to 8.7% 
(calculated by bootstrap). The statistical significance of the 
observed increase in NPV was borderline. 

Performance characteristics of OVA1® with pre-surgical 
assessment for the 269 patients classified according to their 
menopausal status are presented separately in the tables 
below. 

Pre-menopausal subjects 

Among 144 pre-menopausal subjects with pre-surgical 
assessment by a non-GO, there were 26 subjects with 
malignancy by pathology and 118 subjects with no 
malignancy by pathology. 

Table 11. Pre-menopausal non-GO evaluated 
subjects – malignancy/no malignancy by pathology. 

Malignancy by Pathology 
  Pre-surgical 

assessment 
 

  Pos Neg  

OVA1® 
result  

Positive 16 5 21 
Negative 1 4 5 

  17 9 26 
No Malignancy by Pathology 

  Pre-surgical 
assessment 

 

  Pos Neg  

OVA1® 
result  

Positive 7 44 51 
Negative 13 54 67 

  20 98 118 

Table 12. Assessment of pre-menopausal subjects 
by non-GO and by non-GO plus OVA1®. 

Performance Single 
assessment 
(pre-surgical 
assessment) 

Dual 
assessment  
(pre-surgical 

assessment and 
OVA1® Test 
result used) 

Sensitivity 65.4% (17/26) 84.6% (22/26) 
Specificity 83.1% (98/118) 45.8% (54/118) 

PPV 45.9% (17/37) 25.6% (22/86) 
NPV 91.6% (98/107) 93.1% (54/58) 

Prevalence 18.1% (26/144) 

PPV of the dual assessment decreased from 46% to 26% 
and NPV of the dual assessment increased from 92% to 
93%. The confidence interval for the observed 1.5% 
increase was -3.3% to 6.4% (calculated by bootstrap). 

Post-menopausal subjects 

Among 125 post-menopausal subjects with pre-surgical 
assessment by a non-GO, there were 46 subjects with 
malignancy by pathology and 79 subjects with no 
malignancy by pathology. 

 

 

 

 

 

 

 

Table 13. Post-menopausal non-GO evaluated 
subjects – malignancy/no malignancy by pathology. 

Malignancy by Pathology 
  Pre-surgical 

assessment 
 

  Pos Neg  
OVA1® 
result  

Positive 33 9 42 
Negative 2 2 4 

  35 11 46 
No Malignancy by Pathology 

  Pre-surgical 
assessment 

 

  Pos Neg  
OVA1® 
result  

Positive 9 37 46 
Negative 5 28 33 

  14 65 79 
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Table 14. Assessment of post-menopausal subjects 
by non-GO and non-GO plus OVA1®. 

Performance Single 
assessment 
(pre-surgical 
assessment) 

Dual 
assessment  
(pre-surgical 

assessment and 
OVA1® Test 
result used) 

Sensitivity 76.1% (35/46) 95.7% (44/46) 
Specificity 82.3% (65/79) 35.4% (28/79) 

PPV 71.4% (35/49) 46.3% (44/95) 
NPV 85.5% (65/76) 93.3% (28/30) 

Prevalence 36.8% (46/125) 

PPV of the dual assessment decreased from 72% to 46% 
and NPV of the dual assessment increased from 86% to 
93%. The confidence interval for the observed 7.8% 
increase was -1.6% to 17.2% (calculated by bootstrap). 

Performance characteristics for OVA1®, without 
reference to the matched non-GO clinical/radiological 
assessments for malignancy 
OVA1® is not for use as a stand alone test. 
Clinical/radiological evaluation is needed in order to identify 
patients in the intended use population (women over age 18, 
ovarian adnexal mass present for which surgery is planned, 
and not yet referred to an oncologist), for whom the 
performance characteristics of the test are established. 
OVA1® performance characteristics, without reference to the 
matched clinical/radiological assessments for malignancy, 
are summarized in Table 15. 

 

 

Table 15 below shows performance of OVA1® alone for all 
clinical study subjects evaluated by non-GO, and separately 
by menopausal status for pre-menopausal and post-
menopausal subjects. 

Table 15. Performance of OVA1® alonea compared 
to biopsy in patients evaluated by non-GO. 

 All Pre- Post 
N 269 144 125 

Sensitivity 
95% CI 

87.5% 
(63/72) 
77.9% - 
93.3% 

80.8% 
(21/26) 
62.1% - 
91.5% 

91.3% 
(42/46) 
79.7% - 
96.6% 

Specificity 
95% CI 

50.8% 
(100/197) 
43.8% - 
57.7% 

56.8% 
(67/118) 
47.8% - 
65.4% 

41.8% 
(33/79) 
31.5% - 
52.8% 

NPV 91.7% 
(100/109) 

93.1% 
(67/72) 

89.2% 
(33/37) 

PPV 39.4% 
(63/160) 

29.2% 
(21/72) 

47.7% 
(42/88) 

Prevalence 26.8% 
(72/269) 

18.1% 
(26/144) 

36.8% 
(46/125) 

a OVA1® is not intended as a stand-alone diagnostic test. 

A summary of OVA1® results by cancer stage for evaluable 
subjects with a primary ovarian malignancy (EOC and non-
EOC combined) are summarized in the table below. 

Table 16. OVA1® Results by Cancer Stagea for 
primary ovarian malignancies in all evaluable 
subjects with a pre-surgical clinical assessment 
from non-GO. 

 Stage I Stage II Stage III 
No. of Subjects 14 11 25 

OVA1® Mean (SD) 
6.89 

(2.313) 
8.21 

(1.600) 
8.36 

(1.289) 
Median 6.55 8.60 8.70 
Range  

(min, max) 
3.6 to 10.0 5.1 to 10.0 5.5 to 10.0 

OVA1® Positive 
11 
 

11 
 

25 
 

OVA1® Negative 3 0 0 

OVA1® Sensitivity 78.6 % 100% 100% 

a No Stage IV Patients were evaluated by non-GO 

The subjects identified with an ovarian malignancy were 
categorized by histologic subtype. Table 17 shows the 
sensitivity of the OVA1® result for each histologic subtype. 
95.8% of subjects with epithelial ovarian cancer had a high 
risk OVA1® result (≥ 5.0). 
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Table 17. Performance by histological subtype. 
 Patients evaluated by Non-GO 
 OVA1® Risk 

Histological Subtype Low Risk High Riskb Sensitivity 
% 

Epithelial 1 44 97.8 
Non-Epithelial 2 3 60.0 
Low malignant potential 5 7 58.3 
Metastatica 0 5 100.0 
Non-primary ovarian 
malignancies with no 
involvement of ovaries 

1 4 80.0 

a. Includes subjects with non-ovarian primary malignancy 
with involvement of the ovaries. 

b. High risk cut-off: premenopausal subjects OVA1® result 
of 5.0 or more; postmenopausal subjects OVA1® result of 
4.4 or more. 

Performance of OVA1® for Patients Evaluated by 
Gynecologic-Oncologists (GO) 
OVA1® results in patients evaluated by GO physicians were 
analyzed for comparison with results in patients evaluated by 
non-GO physicians. 

The following table shows results for the 247 patients 
evaluated by gynecologic oncologists in the clinical study. 
There were 89 subjects with malignancy by pathology and 
158 subjects with no malignancy by pathology. Compared to 
use of OVA1® in the non-GO evaluated patients, use of 
OVA1® increased sensitivity and decreased specificity in the 
GO-evaluated patients. 

Table 18. GO evaluated subjects – malignancy/no 
malignancy by pathology. a  

Malignancy by Pathology 
  Pre-surgical 

assessment 
 

  Pos Neg  
OVA1® 
result  

Positive 67 19 86 
Negative 2 1 3 

  69 20 89 
No Malignancy by Pathology 

  Pre-surgical 
assessment 

 

  Pos Neg  
OVA1® 
result  

Positive 29 77 106 
Negative 11 41 52 

  40 118 158 

aThere were three Stage IV Patients evaluated by GO 

Table 19 below shows results for all subjects evaluated by 
GO physicians, with ”positive” results for likely malignancy 
either based on a positive pre-surgical assessment alone 
(single assessment), or based on a positive result from the 
pre-surgical assessment or from the OVA1® result or from 
both (dual assessment). 

Table 19. GO evaluated subjects – assessments. 
Performance Single 

assessment 
(pre-surgical 
assessment) 

Dual 
assessment  
(pre-surgical 

assessment and 
OVA1® results 

used) 
Sensitivity 77.5% (69/89) 98.9% (88/89) 
Specificity 74.7% (118/158) 25.9% (41/158) 

PPV 63.3% (69/109) 42.9% (88/205) 
NPV 85.5% (118/138) 97.6% (41/42) 

Prevalence 36.0% (89/247) 

With dual assessments within the GO-evaluated patients, 
sensitivity for malignancy increased from 78% to 99% and 
specificity for non-malignant diagnoses decreased from 75% 
to 26% with dual assessment. The PPV decreased from 
63% to 43%. However, the NPV increased from 86% to 
98%. The confidence interval for the observed 12.1% 
increase was 5.7% to 18.6% (calculated by bootstrap). The 
observed increase in NPV was statistically significant. 

Analytical Performance 
Precision 
Precision performance of OVA1® was evaluated in 
accordance with CLSI guideline EP5-A2 “Evaluation of 
Precision Performance of Quantitative Measurement 
Methods; Approved Guideline.” Five serum specimens 
spanning OVA1® result range (range of numerical results for 
OVA1®: 0.0 to 10.0) were tested over 20 days, two runs per 
day, and two replicates per run. Total percent coefficient of 
variation (%CV) was ≤ 5.2%. 

Table 20. OVA1® Result Precision 
Sample n OVA1® 

(Mean) 

Within-run Between-
run 

Total 

SD %CV SD %CV SD %CV 

1 80 2.74 0.065 2.4 0.011 0.4 0.091 3.3 
2 80 3.39 0.101 3.0 0.099 2.9 0.159 4.7 
3 80 3.74 0.149 4.0 0.097 2.6 0.192 5.1 
4 80 4.69 0.290 6.2 0.000 0.0 0.349 7.4 
5 80 9.94 0.061 0.6 0.051 0.5 0.098 1.0 
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Lot-to-Lot precision 
Five serum specimens and a minimum of two control sera 
were analyzed at one site with three different reagent kit lots 
and three different calibrators over three different days by 
one operator. For each of the five specimens and the two 
controls, the mean and standard deviation (SD) for each 
sample were calculated. The %CV for between-lot 
imprecision was ≤ 2.8%. 

Reproducibility 
Five serum specimens spanning the OVA1® result range 
and a minimum of two controls per day were tested in 
duplicate, two runs each day, over 6 days, by two operators 
at each of three sites For each of the five specimens, the 
mean, SD, %CV, median, and range of OVA1® results were 
calculated for an assessment of imprecision in the 
reproducibility study. The results for OVA1® are shown 
below: 

Table 21. Assessment of imprecision from 
reproducibility study 

 
Serum Specimen 

1 2 3 4 5 

OVA1® result 

Mean  2.67 3.21 3.75 5.00 9.71 
Repeatability SD 0.069 0.094 0.157 0.364 0.157 

 (within 
run) 

%CV 2.6 2.9 4.2 7.3 1.6 

Between run SD 0.034 0.087 0.091 0.000 0.129 
 %CV 1.3 2.7 2.4 0.0 1.3 

Between day SD 0.000 0.000 0.146 0.032 0.045 
 %CV 0.0 0.0 3.9 0.6 0.5 

Between 
operator 

SD 0.042 0.039 0.105 0.265 0.000 

 %CV 1.6 1.2 2.8 5.3 0.0 
Between sites SD 0.057 0.141 0.000 0.103 0.212 

 %CV 2.1 4.4 0.0 2.1 2.2 

Reproducibility SD 0.098 0.176 0.250 0.447 0.271 
(total) %CV 3.7 5.5 6.7 8.9 2.8 

Note: Contributions to variance from nested model for runs 
within days within operators within sites. 
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Interference 
Three pooled serum samples with low (~3.0), medium (~4.4) 
and high (~7.3) OVA1® results were evaluated for 
interference by hemoglobin (9.0 g/L) , conjugated bilirubin ( 
(0.9 g/L) and unconjugated bilirubin (0.9 g/L)), triglycerides 
(4.6 g/L) and rheumatoid factor. No significant interference at 
the concentrations evaluated was observed on the OVA1® 
result for any of the interferents evaluated except for 
rheumatoid factor. Specimens with rheumatoid factor greater 
than 250 IU/mL are not appropriate for OVA1®. 
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© 2020. The OvaCalc software of the OVA1® test is the 
copyright property of AWH, Inc. All rights to this software are 
retained by AWH, Inc. 

The OvaCalc software is licensed to customers pursuant to 
AWH’s standard end user license agreement. 

Customers may need to obtain intellectual property licenses 
to perform any biomarker assays referenced in this 
document from the manufacturers of applicable diagnostic 
instruments or systems. No such licenses are provided by 
AWH, Inc. 

OVA1® is a trademark of AWH, Inc. Cobas is a registered 
trademark of Roche Diagnostics. 
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